
Using the ONFC Excel Macro Package 1

Using the ONFC Excel Macro
Package
written by Stephen Gabe

Version 4.5
January 13, 2008

Table of Contents
Getting Started ................................................................................................................................................2

Requirements ....................................................................................................................................2
Installing or upgrading the ONFC macro package ...........................................................................2
Running the ONFC macro package ..................................................................................................2

Creating an Order ............................................................................................................................................2
Starting a new order ..........................................................................................................................2
Entering orders..................................................................................................................................3
Combining orders from club members .............................................................................................5
Collating the order for the ONFC .....................................................................................................6

Processing a Received Order...........................................................................................................................6
Sorting the order ...............................................................................................................................6
Updating the orders...........................................................................................................................7
Checking prices and delivery information on the invoice ................................................................8
Handling errors ...............................................................................................................................10
Tax, 2% surcharge and other anomalies .........................................................................................11
Printing the orders...........................................................................................................................11
Unloading the ONFC software .......................................................................................................11

Adding Items to the Catalogue......................................................................................................................12

Order Processing Options .............................................................................................................................13

About the Files ..............................................................................................................................................14

Known Problems...........................................................................................................................................15

Version Change Summaries ..........................................................................................................................16

Software Distribution Conditions..................................................................................................................19

Contact Information ......................................................................................................................................19



2 Using the ONFC Excel Macro Package

Getting Started

Requirements
To use this software you require Microsoft Excel. This software will work on either a PC
or a Mac.

Installing or upgrading the ONFC macro package
To install, or upgrade, the ONFC macro package either (i) copy all files on the diskette,
(ii) detach all the files from the email, or (iii) download all the files from the ONFC web
site to the same directory (either a new one or an existing one) on your computer's
internal disk. If upgrading from an older version, replace the old files with the new ones
(you may, optionally, want to rename the old files first, until you are sure that the new
version works fine). Do not rename any of the new files otherwise you might find that
some functions of the package will not work. If interested, refer to About the Files on
page 14 for a description of all the files.

Running the ONFC macro package
To start the ONFC Excel macro package start Excel and open the ONFC.XLM macro file
(in the directory it was copied to). When opening the file you may receive a warning that
the file contains macros. In this case you must click on Enable Macros for this software
to work. This will cause the ONFC macro functions to be loaded and the catalogue to be
opened ready for use. The macro functions provide the ability to create new orders, look
up order codes to find product information, generate a master order for faxing, etc. The
functions use a catalogue spread sheet (CATALOG.XLS) as the source of all the product
information for all the products available from the ONFC. It contains product
descriptions, single and case costs, sizes, singles per case, etc. It is required by the macro
Look Up Codes function to fill in all the order information.

After opening ONFC.XLM, a menu entitled ONFC will be added to the Excel function
menus. This menu provides access to all the order processing functions. While the
catalogue and macro files need to be open, you should not need to look at or alter them
(in fact, they are normally hidden from view). The catalogue file will need to be updated
every few months as the ONFC catalogue itself is updated. The ONFC makes the updates
available on the web.

Creating an Order

Starting a new order

To start (create) a new order select Start New Order from the ONFC menu. This will
cause a new order sheet, with all the correct titles, to be created. At this point the new
order should be saved so that it can be named. A convenient file name convention to use
for this is the order delivery date (e.g. 07FEB15.XLS).
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Entering orders
By default, new orders start with data entry mode enabled. Data entry mode allows
orders to be typed more quickly since it automatically looks up codes you enter and
moves the active cell (cell surrounded by a dark black box) to the next field to fill in each
time you hit the Enter or Tab key. To enable/disable data entry mode, simply select it in
the ONFC menu. The description below assumes you have data entry mode enabled.

Enter each person’s order one by one. To do this:

1. Start an individual or family's order by putting their name in the next empty cell
in the Name column. You can use the cursor arrow keys to move the active cell to
the Name column, if required. Do not leave a space (empty row) between the
previous person's order (or the titles row if this is the first person's order) and the
new order. If you do, it will cause no harm, but it will be removed when you sort
the order.

2. Enter a code for the person’s order in the Codes column. There is no need to fill
in the page, vendor, description, etc. Simply enter the code (using lowercase is
fine) one per row in the form xxxnnn (e.g. che002). You do not need to put a
space between the letters and numbers. After you type in the code and hit the
Enter or Tab key, the code you have just typed is automatically looked up in the
catalogue file and the vendor, description, price, etc. for that code is filled in in
your order. The active cell is then moved to the Num column.

If information associated with an entered code was not filled in (description, cost,
etc. are blank and active cell still in the code column) then the specified item was
not found in the catalogue. Check that the code you entered is correct (some
common errors include: miss typing the code and typing O instead of 0 (zero) or
vice versa). Simply correct (or just reenter) the code in error and hit the Tab or
Enter key again to look it up.

If the code is correct, but not found in the catalogue, there may be a catalogue
error or the item may be a new one since the catalogue was last updated (e.g. a
new item listed on a "specials" flyer). In this case, after looking it up in the
catalogue (so that the formulas for that item will be set), you should enter the
vendor, description, flavour, single and case costs, size and singles per case
information by hand. Once this is done, don't look it up in the catalogue again (i.e.
don’t hit Tab or Enter while the active cell is positioned on that item’s code) or
the information you entered by hand will be cleared.

Important Note: When entering the information associated with a new item (e.g.
from the “specials” flyer) by hand, if you do not know how many items there are
in a case then set the S/Cs column number to a large value (e.g. 1000). The reason
for this is that this number is used to convert multiple singles ordered into cases.
If this number is set to 1, for example, and 3 singles get ordered, this will be
converted to 3 cases on the collated order (fax) sheet!

3. Now (the active cell should be in the Num column), enter the number of singles
or cases to be ordered for this item. If cases are to be ordered, then enter the
number with a ‘c’ appended to it (e.g. enter: 2c). When you hit Enter or Tab, the
active cell is moved to the Code column in the next row, ready for the next item.
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If the number you entered had a ‘c’ appended to it, then a ‘C’ is automatically
entered in the SorC column.

A ‘C’ (or ‘c’) in the SorC column indicates that case(s) are to be ordered. When
the SorC column is left empty (or contains ‘s’ or ‘S’) then the software assumes
singles are to be ordered for that item. When you entered the number and case
designation (if required), the total cost for the item is calculated and can be
compared against total costs filled out on people's order forms (assuming they are
provided). This acts as a convenient double check that no mistakes have been
made.

Note: Some items can only be ordered by the case, or half case. When this is the
situation, the Fu/Ha column will indicate Fu (full cases only) or Ha (half or full
cases only). Ensure that the total ordered (across the entire order) for such items
meets the corresponding full or half case designation (otherwise an error will be
reported when you later collate the order). Orders can be entered as cases (or 0.5
cases) or the appropriate number of singles. For half case only products, that
contain an odd number of singles per case, you can round up or down to the
nearest half case amount (e.g. if product contains 15 singles/case then half case is
either 7 or 8 singles). When collating the order for the ONFC, the software will
always round up when converting fractional case amounts to singles.

4. Repeat this process until all the orders are entered. Remember to save your work
periodically as you go along. Notice that the person’s name associated with an
item is automatically copied from the row above after you enter each code. When
you start entering a new person’s order, remember to first type their name in the
Name column.

You don't have to worry about the order in which you enter items for each person’s order.
Later, as the orders get processed, each person's order will be sorted into the same order
as the items appear in the catalogue.

If some of the items you order are on special, there is no need to correct their prices at
this time. The invoice you receive when the order is delivered will contain the specials
prices and you can correct them then (typically you will have to do this step at that time
even if no specials were ordered).

You may prefer to work in a mode in which you first enter all the codes for a person’s
order, and then enter the number for each of the items. If so, select the Options… item
on the ONFC menu and set the Data entry mode Enter key movement selection to Down.
This will cause the Enter key to move down after entering a code or a number, instead of
across. The Tab key will still move across rows.

The mouse or cursor arrow keys can be used to move the active cell at any time, when
required. The Enter and Tab keys movement behaviour are simply provided for
convenience, but may not always go where you want to go next! Also, if you make an
error in the last cell you entered, you can use Shift-Enter and Shift-Tab keys to move
back to the previous cell to make corrections.

As mentioned, the description above assumes that you have Data Entry Mode enabled.
If this is not the case then codes will not be looked up automatically and the active cell
will not jump between the Code and Num column automatically. In this case, to look up
the codes, select the codes you have entered (typically, with the mouse, by clicking down
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and dragging from the first entered code to the last one). Now look up the selected codes
by choosing the Look Up Codes item from the ONFC menu (or type Cntrl-l). All the
information (page, description, prices, etc.) associated with the entered codes should now
be filled in. In addition, the person’s name entered in the first row of their order should
be copied all the way down the Name column. Now you will have to enter the number of
items in the Num column and put a ‘C’ in the SorC column (for cases) when appropriate
(note that you can not enter numbers in the form ‘2c’ in the Num column if data entry
mode is disabled).

Once all the orders are entered, if you wish to see the total cost for each person's order as
well as the grand total for all the orders, select Add in Totals from the ONFC menu. This
will cause the tax, surcharge, and total information for each person's order to be added
after each order. The grand total for the entire order is also added at the end. To remove
all of the totals information, select Remove Totals from the ONFC menu (this must be
done before generating the fax order, described below).

If you need to add items to a person's order, after having already entered other orders
below it, simply insert a row below their order (click on the left hand row number below
their order and select Insert from the Edit menu). Now enter the item code and look it up,
as described above. Don't worry about trying to find the correct catalogue position for the
item, it will get sorted into the correct position automatically.

Combining orders from club members
If you have many, or all, members in your club that are using the ONFC Excel Macro
package to create their orders, then you will need to combine all their orders into one file
to collate for the ONFC. To do this have the members create their order as described
above. They should then either email the file (as an attachment to the email), or save the
file on diskette to hand over, to the person who will be collating the order and sending it
to the ONFC.

After starting a new “master” order, the collating person can then detach the file from the
email and open it, or open it from the diskette. Once opened in Excel, select all the data
rows of the file (click on the row number itself, starting at row 2, and drag downwards to
select all data rows in the file). It is important to select entire rows so that all hidden
columns will be copied over (e.g. column S). Then select Copy from the Edit menu. Now
return to the “master” order file by selecting it under the Window menu. Position the
active cell in column A of the next empty row and select Paste from the Edit menu. This
process can be repeated for other member’s orders. Once all the member’s orders have
been combined (copy and pasted) into one “master” order, proceed to the next step,
below.

Note that if a club member has used an old version of the catalogue file to generate their
order, then it is a good idea for the collating person (using a new version of the catalogue
file) to repeat the step of looking up all the codes that were pasted into the master order.
This is done by selecting all the pasted codes and then selecting Look Up Codes from
the ONFC menu.
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Collating the order for the ONFC
Once all the orders are entered (and saved) it is time to generate the collated order ready
to email or fax to the ONFC. Do this by selecting the Generate ONFC Order from the
ONFC menu. This will cause a new sheet to be opened which contains a list of all the
items and total number of singles and cases for each that must be ordered. The original
order sheet is left just as it was when this step was performed (and should be saved for
use when the order is delivered).

Note that when you collate the order error checking is performed. If there are errors in
your order you will be informed and will have to correct the errors before trying again.
Error checks are done to ensure no discontinued items are ordered, that half/full case
items sum to valid totals, that no key cells are empty, etc.

Once the list is generated you will be prompted for information concerning the delivery
date, address, contact person's name, etc. Also enter the month of the specials you used
for creating the order. Fill in the information and click the OK button once complete.
Tip: Use the tab key to move between fields in the information prompt box.

If you accidentally click the OK button too soon (or hit the enter key), select Alter
Order Header Information from the ONFC menu to be prompted again.

The collated order file is protected to prevent accidental modification before sending to
the ONFC. If corrections are required after collating the order make them in the original
order file and generate the order again.

At this point you can save and attach the collated order file to an email that you send to
the ONFC. Alternatively you can print this sheet and fax it to the ONFC or, if your
computer supports a fax modem, fax it directly without printing it.

Once complete, you can save a copy of the collated order list. I usually keep a copy of the
collated order list only until the order is delivered and processed (in case any questions
arise before delivery). After that it is of little use.

Finally, before the order is delivered, you may want to print a sorter's list in advance.
Refer to the start of the next section for more information about this.

Processing a Received Order
Much of the information described here assumes you will use the computer to help
process the orders once sorted. If this is not possible, print the order summaries (see
Printing the orders, below) and sorter's list (see below) in advance and, after sorting the
orders, adjust the summary totals (and tax, etc.) by hand for any items that did not arrive.

Sorting the order
Once the complete order is delivered, there are two approaches that can be taken to
sorting the delivered order into individual orders. One approach is to gather all the items
for one person's order together, repeating the process for each individual. The second
approach is to distribute the items to all the individual's orders. This approach can be a bit
more efficient since multiples of the same item can be distributed to different individual
orders quickly (rather than having to locate that same item multiple times over). In other
words, it cuts down on searching time. Each approach is described below.
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Sort method 1: Gathering together each individual order
Print a copy of each person's order for use when sorting the orders. Printed orders,
with complete descriptions, tend to be easier to use when sorting than hand written
orders are. To do this, go back (if it is closed, open it) to the worksheet with the
orders you entered and select Prepare for Printing from the ONFC menu. This will
cause all the orders to be prepared for printing, one order per page, with each person's
name at the top. Now, print the orders by selecting Print... from the File menu. To
sort, go through the printed orders, one at a time, and find each item listed.

Sort method 2: Distributing items to individual's orders
Generate a sorter's list for use when sorting the orders. To do this, go back (if it is
closed, open it) to the worksheet with the orders you entered and select Generate
Sorter's List from the ONFC menu. This list itemizes all the products that have been
ordered down the left side of the page and people's names across the top of the page.
Individual's ordered items are indicated, as required, at any intersection point. This
list can either be:

(i) printed as is, in which case items are listed in the same order as they are on the
invoice, or

(ii) sorted by description before printing (select Sort by Description from the
ONFC menu to do this). In this case items may be easier to find when sorting
since vendor names are listed alphabetically and are sorted together, but will be
harder to locate on the invoice.

To avoid wasting time looking for undelivered items, find all the items on the
invoice that were not delivered and cross them off on the sorter's list. This is
particularly easy to do if the list is in the same order as the invoice. This is
another advantage of using method (i) of sorting.

After printing the sorter's list, close the list without saving it (select Close from
the File menu).

Note that the Re/Fr column indicates items that require refrigeration or freezing.

Regardless of which method you use, while sorting, be sure to mark on sorting lists all
items that did not arrive or were not complete (e.g. 3 ordered, but only 2 shipped).
Also, if extra, unordered items (assuming extra were delivered) are added to someone's
order, make a note of this too. Recording these changes is especially important if
someone else will be using this information later to update the orders on the computer.

Updating the orders
Once sorting is complete, return to the computer with the hand corrected sorting lists.
Open the worksheet containing people's orders. If the totals are entered below each
person's order then remove them by selecting Remove Totals from the ONFC menu.
This allows more information to be displayed on screen at once.

Now enter the corrections noted on the corrected order forms (sort method 1) or sorters
list (sort method 2). To do this, first sort the order on screen into the same order as the
corrected lists you are working from (if it is not already in that order). This is done by
selecting the appropriate sort function from the ONFC menu. Now locate the items, one
by one, on screen that need updating and change the entry in the Num column for each
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item that is incorrect. Since the order on screen matches the list order, items to be
updated should be quick to find. If the item did not arrive at all set its Num entry to 0.
You may have to do this for multiple rows on the screen if more than one person ordered
that item (this is easy to do when working from a sorter’s list since the items will be
sorted together). If less arrived than were ordered set it to the number received (for the
appropriate person). As you do this (after changing a number and hitting enter) the total
for the item will be adjusted. Sometimes when a case(s) of an item is ordered, one or
more singles are shipped instead. If this happens, in addition to adjusting the Num entry
for the item, the 'c' (or 'C') in the SorC column will have to be deleted (or changed to a
‘s’).

Some items, such as cheese, can be shipped as fractional singles (e.g. 3 ordered, 3.1
delivered). When this occurs (check the invoice to see), adjust the Num entry for such an
order to reflect the amount received (e.g. set it to 3.1). If the singles ordered are split
between two or more people's orders, the only accurate way to check how much each
person received is to weigh the items! If you can live with a small error, simply split the
fractional difference between people's orders.

If unordered item(s) have been added to someone's order (with a different code from any
item in their order), insert a new row on screen, one per new code, and enter their name
in the Name column (make sure you spell it exactly the same way as it is spelled for the
rest of their order) and code(s) for the item(s). Now select the codes (click and drag over
the codes) and look them up in the catalogue by selecting Look Up Codes in the ONFC
menu.

Repeat this process until all the corrections are entered. Once complete, if required, you
can sort the orders by name by selecting Sort by Name from the ONFC menu.

Tip: When making the corrections it is most convenient to try to maximize the amount of
data you can see on the screen at once (to avoid having to constantly adjust what you are
looking at). To do this maximize the Excel window as well as the order window you are
working with in Excel (use the buttons in the top right corer of the window). After doing
this, if all the columns (from Name, on the left to Total, on the right, do not fit on the
screen at once, either:

• shrink the size of some columns (e.g. Vendor, Description and/or Flavour)
somewhat until they do fit (assuming a small adjustment will be enough). To do
this, position the pointer over the line between the E and F above the Description
and Size columns (watch for the double ended arrow with a vertical line through
it to appear) and click and drag left. See the description of the ORDER.XLT file
in the About the Files section of the manual for information about how to do this
permanently for all new orders.

• adjust the zoom associated with the display to 90% or 80%. Adjust this in the
toolbar or under the Zoom ... option of the View menu.

Checking prices and delivery information on the invoice

Once all the corrections from the order forms are entered it is necessary to ensure that the
order information on screen and the invoice agree. Usually, the simplest first step is to
see how close your calculated total is to the invoice total. To generate this, select Add in
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Totals from the ONFC menu. If the grand total on screen is close to the invoice total,
there is a good chance that your order information is correct. If not, or if you want to be
sure, the steps below describe how to proceed.

First sort the order into the same order as it is in the catalogue, which is also the order the
invoice is in. To do this select Remove Totals (assuming you added them in, above) and
then Sort into Catalog Order from the ONFC menu.

Go through the items on the invoice one by one. Check for the following:

1. If only one person ordered the item then the totals on screen and in the invoice
should match. If they do, then go on to the next item. If they don't, check

(i) if the number ordered/delivered match, or

(ii) if the single/case indication match, or

(iii) if the single/case prices (depending on which is appropriate) match.

If the prices don't match, adjust the single or case price, as appropriate, for that
item on screen. If the number of singles/cases or singles/cases designation does
not match then there is either an error in the invoice or in the person's order.
Check carefully (check the corrected order form, sorter’s list or the actual order
itself) to ensure that your information on screen is correct. If it is, then make a
note of the error on the invoice and continue.

2. If more than one person ordered the item then the sum of the totals for that item
on screen (they will all be together because of the sorting) should match the
invoice total. To check that they do either mentally add up the totals for the items
or ensure that the single/case prices match and that the total number of
singles/cases match the invoice (if they do the totals are sure to match too). Once
again, when there is a discrepancy, check in more detail as described in step 1
above.

Note that all items that did not arrive, and which have already been set to 0, should all be
shown with 0 shipped on the invoice.

Remember to save your corrections periodically as you work. Select Save from the File
menu to do this.

Tip: When working in a pair, one person can read information from the invoice (typically
total price for each item shipped) while the other checks and updates information on
screen. This is quite quick to do since the order of the items is the same in both places.

Once everything has been checked and corrected, the totals for each person's order, as
well as the grand total for the entire order, can be generated (or regenerated). Select Add
in Totals from the ONFC menu (it is not necessary to select Sort by Name first as this
will be done automatically).

If there were no invoice errors (e.g. charges for a product that was not shipped), the grand
total for the entire order on screen (at the bottom of the order) should now match that on
the invoice (or come reasonably close). Note that you can change the Freight and COD
Discount fields (set them as appropriate) if the default values are not correct for your
order. If there were errors or other discrepancies (tax or 2% surcharge mismatch), refer to
the next sections. Otherwise refer to the section about printing.
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Handling errors
When there are errors on the ONFC invoice, its total will not match the calculated grand
total. This makes it is difficult to know if any other errors may have slipped by. To
overcome this problem, and to have a record of the invoice errors, make dummy entries
for the items in error. To do this first remove all the totals from the order (if they have
already been added in) by selecting Remove Totals from the ONFC menu. Now, at the
bottom of the order, enter the codes of the items in error. Set the Name field for these
items to ZZError (so they will always be sorted to the bottom of the order). Now select
(click and drag) the codes entered and look them up in the catalogue by selecting Look
Up Codes from the ONFC menu. Update the rest of the information as follows:

• for items that were not shipped but which were charged for on the invoice, insert a
comment at the start of their description stating "Not shipped, charged". Set the Num
and SorC fields to indicate the quantities involved. Note that if only some of the
ordered items were shipped (e.g. 5 ordered, only 3 shipped but still charged for 5)
then the Num field should be set to indicate only the discrepancy (e.g. from previous
example: 2).

• for items that were shipped but which were not charged for on the invoice, two
situations are possible:

(i) if the items were not taken by anyone, and are to be returned to the ONFC,
insert a comment at the start of their description stating "Shipped, not
charged, to be returned". Set the Num and SorC fields to indicate the
quantities involved and also set the Total field to 0 (that is, change the
automatically calculated total for the item to 0). This type of entry simply
acts as a record of the errors that occurred in the order but does not affect
the calculated grand total.

(ii) if the items were taken by someone, insert a comment at the start of their
description stating "Shipped, not charged, taken by <person's name>". Set
the Num and SorC fields to indicate the quantities involved. Since the items
were taken, they should have been charged for on the individual(s) order
already. So, in order to counteract the effect this had on the calculated grand
total, change the Num field for each item to be negative (e.g. 2 becomes -2).
This will allow the grand total to match the invoice.

Once all the error entries are complete, add in the totals for the order once again by
selecting Add in Totals from the ONFC menu. The ZZError entries will now have their
own totals section. If the errors total amount is positive, then the buying club is owed this
amount from the ONFC. If negative, the buying club owes this amount to the ONFC.

At this point the grand total for the order should match, or be close to, the total on the
invoice. If it is not, and the section below does not explain the discrepancy, then there are
error(s) on one or more orders. If the error is large enough to be of concern (greater than
$10 perhaps) you will have to check over people's orders once more as has been
previously described.

The error record section is a useful reference for the order prime when calling in the
errors to the ONFC. It can also be useful, in the future, to ensure that credit notices sent
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to the buying club are correct. For this reason, don't forget to save all your changes when
complete.

Tax, 2% surcharge and other anomalies
One point to take note of is that the calculated tax grand total may not quite match the
invoice tax total. It can be tricky to tell if the software and the invoice agree on which
items are taxable. The invoice usually states "PG" or "pg" in the item descriptions if an
item is taxable, but sometimes they are missing. To tell for certain, compare invoice
column "Ext Price" with "Ext Amt + Taxes". If the latter is larger then the item is taxable.
In this case there should be a PG against the item in the TaxT column in your order file,
and no PG if smaller.

A second point to note is that a 2% surcharge is automatically added to each person's
order if the grand total for the entire order is less than $1000. This can sometimes be
incorrect (e.g. if $1100 worth was ordered but only $950 worth was delivered). If the
invoice indicates that no surcharge was applied, but it has been on screen, then after
adding in the totals simply change the calculated Grand 2% Surcharge, field at the end
of the on screen order to 0. This will automatically cause the 2% surcharge on each
person's order to also be set to 0. If for some reason you remove and then later add in the
totals again, you will need to repeat this step.

Also, as mentioned earlier, you can change the Freight and COD Discount fields (set
them as appropriate) if the default values are not correct for your order.

Printing the orders
Once you are satisfied that the information on screen for each person's order is correct,
prepare the order for printing. To do this, select Prepare for Printing from the ONFC
menu. This causes a title row (which includes the order person's name) and page break to
be added above each person's order. It also causes some of the columns (e.g. the Name
column) to be hidden, which makes more room for complete descriptions on the page. By
default the orders will be scaled to fit on a one page wide portrait page. You can also
adjust the some column widths, especially the Vendor, Description or Flavour columns,
if you desire (so printed invoices will be more complete).

When you are happy with how things look on screen, print the individual invoices by
selecting Print... from the File menu. Finally, once printing is complete, put the printed
invoices with their sorted orders and go home!

Unloading the ONFC software

Once you have finished processing an order, you can exit Excel. If you wish to continue
using Excel, but not the ONFC package, you can unload the ONFC package by selecting
Unload ONFC Package from the ONFC menu.

When you close Excel you may get a message asking “Do you want to save changes you
made to ‘Onfc.xlm’?”. You can safely answer “No” to this question. The reason that this
message gets generated is that internal variables in the Onfc.xlm file get updated when
you use the software; however, these variables do not need to be saved.
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Adding Items to the Catalogue
Sometimes, during the course of the year, new items become available from the ONFC
(e.g. in the specials). If you wish to add these items to the catalogue so that they can be
used to assist in order processing, follow these steps:

1. Open the CATALOG.XLS file. This file is normally hidden, so you may need to
unhide it after opening it by selecting Unhide... from either the File or Window
menu.

2. Unprotect the file by selecting either Unprotect Document... from the Options
menu or Unprotect Sheet … from the Tools menu (depends on which version of
Excel you are using).

3. Go to the bottom of the file.

4. Insert new rows, one per item to be added, above the last line in the file.

5. Fill in the information in each row as follows:

• Set the Item No to be one greater than the Item No in the line above.

• Set the Page to be equal to the line above.

• Set the Code to the new item's code. Use uppercase for letters. Do not insert a
space between the letter and number parts of the code.

• Enter the name of the vendor (company name) that produces the product in
the Vendor column (e.g. Eden, Spectrum, Oak Manor, Frontier, etc.).

• Enter a description of the type of product in the Description column (e.g.
Juice, Beans, Flour, Salad Dressing, Cereal, Pasta, Tea, etc.)

• Enter the details that describe this particular product in the Flavour column
(e.g. particular type of tea, cereal, oil, pasta, etc.)

• If the product is an organic product, enter O in the Org column. Otherwise
enter a single space (“ “) in this column. This space causes long descriptions
in the Flavour column not to overlap other columns, which can be confusing
to read.

• If the item is a refrigerated item, enter Re in the Re/Fr column. If it is a frozen
item enter Fr in this column. Otherwise leave it blank.

• If the item can only be ordered by the half and/or full case only, enter Ha (half
or full cases only) or Fu (full cases only) in the Fu/Ha column.

• Enter the product Size. Include the size of each item in the case, if appropriate
(e.g. 300 g). If the item can only be ordered by the case then also include the
number of items per case in this field (e.g. 12/300 g)

• Enter the number of items per case in the S/Cs column. If the product can
only be ordered by the half or full case, set this field to 1 (even if there are
more than one item per case). If you do not know how many items there are in
a case then set this number to a large value (e.g. 1000). The reason for this is
that this number is used to convert multiple singles ordered into cases. If this
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number is set to 1, for example, and 3 singles get ordered, this will be
converted to 3 cases on the fax sheet!

• Fill in the single and case prices as appropriate (if one or the other is
unknown, leave it empty). If the product can only be ordered by the half or
full case, set the single price to be the same as the case price.

• Enter G and/or P in the TaxT column if the item is subject to GST and/or
PST, respectively.

6. Optionally, once complete, protect the data by selecting either Protect
Document... from the Options menu or Protect Sheet … from the Tools menu
(depends on which version of Excel you are using). Don't provide a password in
the prompt box (they are too easy to forget). Protecting the document is simply
done to prevent accidental modification.

7. Save and then hide (under the Window menu) the file. When you exit Excel, if it
again asks you if you want to save changes to the catalogue, say yes (Excel
considers hiding the file to be a change).

Order Processing Options
The ONFC menu function Options … can be used to alter order processing options. The
options provide:

• the ability to turn on or off  yellow backgrounds in the order total cells (some people
found them hard to read when printed),

• whether or not to automatically turn on data entry mode when you start a new order,

• the preferred movement (across or down) to associate with the Enter key when in
Data Entry mode (note that the Tab key always moves across),

• whether or not to include the 2% surcharge on each person’s order total when the
grand total is less than $1000 (some clubs collect dues to cover this charge),

• the delivery charge (freight) amount,

• whether or not to include the COD (Collect On Delivery) discount formula in
individual and grand total calculations (some clubs don’t pay COD),

• whether or not to divide the freight charge equally across the individual orders.

• the PST and GST rates, entered in decimal format (e.g. 0.08).

In addition, the ONFC menu function Alter Order Header Information … can be used
to alter the information associated with the active collated order (Fax) worksheet and also
for any future collated order worksheet that is generated using the Generate ONFC
Order menu function.

The options and order header information settings that you set are all stored in the
OPTIONS.XLS file.
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About the Files
This section briefly describes the files that come with, or are generated by, the ONFC
Excel Macro Package. Note that the three letter file extensions shown below may be
hidden from view depending on the options you have set on your PC.

CATALOG.XLS This is the source of all the product information. It is used by the
Look Up Codes menu function and when Data Entry Mode is
enabled. By default this file is loaded automatically and hidden
from view when the ONFC software is stared.

ONFC.XLM This contains the macro package code that implements the
ONFC menu functions. Opening this file starts Excel and enables
to software for use (creates the ONFC menu in Excel).

ORDER.XLT This is the template for a new order sheet. It is used by the Start
New Order menu function. This file is automatically created by
the software the first time the Start New Order menu function is
used.

If you wish to change the default column widths of subsequently
created new orders, then, from within Excel select Open… from
the File menu to open this file (once it has been created). Find
the file in the pop up window and then open it with the shift key
held down. Alter the column widths (and any other
characteristics you like, such as font type, size, etc.) and then
save the file. Holding the shift key when opening the file causes
the template file itself to be opened rather than a new blank
worksheet based on the template.

FAX.XLT This is the template for the collated order (Fax) summary sheet.
It is used by the Generate ONFC Order menu function. This
file is automatically created by the software the first time the
Generate ONFC Order menu function is used. If desired, its
default column widths, font, etc. can be altered in the same way
as described under the ORDER.XLT file above (once the file has
been created).

SORTLIST.XLT This is the template for the sorter's list. It is used by the
Generate Sorter's List menu function. This file is automatically
created by the software the first time the Generate Sorter's List
menu function is used. If desired, its default column widths, font,
etc. can be altered in the same way as described under the
ORDER.XLT file above (once the file has been created).

INSTRUCT.DOC Microsoft Word version of this manual.

INSTRUCT.HTM HTML (Web) version of this manual.

ORDFORM.XLS A sample order form, done in Excel, which can be printed and
distributed to club members for use in placing orders. This form
is designed to be filled out by hand and handed in to whoever is
collating the club's order. Before printing, fill in the club's name
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in the Header section of the Page Setup dialog box (under the
File menu). You may also need to adjust column widths to suit
your printer. Try to ensure all columns print together on one
page.

OPTIONS.XLS This file is created automatically when the ONFC.XLM file is
first loaded in Excel (it is not part of the distributed software). It
is used to store a number of options and buying club information
(as set when using either the Options … or Alter Order Header
Information … ONFC menu functions).

Known Problems
The following is a list of known problems and quirks of behavior associated with this
package:

1. There is a limit to length of the header information (club name, etc.) on the top of
each fax page of 255 characters. When you enter the header information, if it is
too long you will be informed and asked to shorten some of the text you have
entered.

2. If you change the column titles some functions may no longer work properly, so
don't do this!

3. If you reduce the width of a column of numbers (e.g. the Num column) too much,
some numbers in the column may get rounded. An order for 1.5 cases, for
example, may get displayed as 2 cases if the Num column is too narrow. This is a
property of Excel. Take care when adjusting column widths.

4. If two or more people order something that adds up to a full case (or more), then
there is no easy way to assign the small savings in ordering a case to each person.
The only way this can be done is to set each persons order, when this occurs, to
be a fraction of a case rather than the correct number of singles (e.g. 0.5 of a case
rather than 6 singles of a 12 singles per case product).

5. The software expects all its required files to be in the same directory.

6. You can not rename the Excel files used by the software without altering the
macro software. I recommend leaving the names as they are.

7. Some versions of Excel convert codes of the format "MAY008" to the date May
8th! To get around this enter the code, in upper case, with a preceding single
quote like this: 'MAY008

8. When you have Data Entry Mode enabled, it is automatically disabled if you
activate any other worksheet in Excel or Add in Totals to the order. It is not re-
enabled when you activate the original work sheet or Remove Totals.
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Version Change Summaries

Changes in version 4.5
• Add the PST and GST rates to the Options dialog box. Set the default GST rate to

5%.

Changes in version 4.3 and 4.4
• More error checking added when collating orders. Can no longer order discontinued

items. Ensures that full/half case designation is adhered to. Ensure all codes are in
AAAnnn format (3 letters then 3 numbers).

• When the order is collated, decimal case amounts are converted to cases + singles
amount on a separate line.

• Can no longer modify the collated order file (file is protected after it is generated).

• Order header information must be filled in when generating the order for the ONFC.

• Changed the GST tax rate to 6%.

Changes in version 4.2
• Tax handling improvement.

Changes in version 4.1
• Fixed the macro error that occurred when you tried to generate the ONFC order or

generate the sorter’s list if the name of the order file you had created had spaces or
other unusual characters in it. Specifically, the errors were: “Macro error at cell:
[Onfc.xlm]Onfc!B701” and “Macro error at cell: [Onfc.xlm]Onfc!B1005”. This
problem was introduced in version 4.0 of the software. You can now use spaces in the
names of order files you create.

• Modified the tax calculation formulas to include the GST on the freight charge (since
the ONFC charges GST on this). It will be included in the grand tax total at the end of
all orders. It will also be included in the tax totals for each person’s individual order
if you have the option selected to share the freight charges across each member’s
order.

• Modified the layout of the collated (fax) order that gets sent to the ONFC to be in
landscape mode. Also increased the size of some column widths and the font size of
the item descriptions. This change was requested by the ONFC since their order desk
staff were having troubles reading the compressed font size that was created when the
order was squeezed to fit to one page wide portrait mode printing.

• Increased the default column width of the Page column in orders to accommodate
three digit page numbers.

• Fixed errors that occurred in some functions if there was only one item in the entire
order.

• Clarified some error messages that the software generates.
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 Changes in version 4.0
• Added 5 new columns of data to the orders. These are Vendor, Flavour, Org

(Organic item), Re/Fr (to indicate a refrigerated or frozen item) and Fu/Ha (to
indicate items that can only be ordered by the case or half case). Now the three
columns Vendor, Description and Flavour fully describe a product. In the past this
information was all combined in the single Description column. The default font size
for these three columns is set to an 8 pt font so that more text will show.

• Added specials date (month) field to the fax page header, and corresponding query
dialog box (that pops up upon collation of an order).

• Changed the term “unit” to “single”, in the titles and in the manual, to align with that
used in the ONFC catalogue. In the column titles, UperCase is now called S/Cs, and
UorC is now called SorC.

• Added the capability to the software to automatically create (or upgrade to the new
format) the template files required by this software. Once the files are created, the
user can format the template files to their liking (e.g. to alter default column widths,
set font sizes, etc.). See the description of the ORDER.XLT file in the About the Files
section of this manual to learn how to do this. You will get a message informing you
of the creation, or upgrade, of these files when they are next accessed. The files are
created in the same directory (folder) as the ONFC.XLM file is in.

• Improved some headers and printing formatting. Set printing to default to one page
wide to avoid the problem of columns of data getting orphaned on separate pages.
Added a page break before the Grand Totals information when an order is prepared
for printing.

Changes in version 3.3
• Added option to specify the membership loan percentage. The default value for this

option is 4%. Once the ONFC stops collecting the membership loan, this value should
be set to 0.

• Added option to specify whether the freight charges should be shared equally across
all orders.

• Slightly modified the COD option to specify if the COD discount should be applied
to individual orders (as well as in the grand total section).

Changes in version 3.2
• Fixed a problem encountered by Mac users in which the Options.xls file would not

get loaded properly.

 Changes in version 3.1
• Fixed the problem with the Onfc.xlm file that caused an error, when loading, that

stated something like “Can not add any more custom formats”. Also, greatly reduced
the size of the Onfc.xlm file. This causes it to load faster.
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 Changes in version 3.0
• Added a new data entry mode that speeds the process of entering orders. In this mode,

each code entered is looked up automatically after you enter it. The active cell is then
positioned at either the correct cell to enter the number of singles or in the next row
ready for the next code (there is an option to select the desired cell movement
behaviour). When in the Num column, case amounts can be entered in the form “1c”,
which will then be converted to a 1, with a C filled in in the SorC column. After
entering a number, the active cell is then advanced to either the next Code or Num
cell. This mode is enabled or disabled with the new Data Entry Mode item in the
ONFC menu.

 In data entry mode, you can still use the arrow keys to move the active cell around
(you will need to do this, for example, when you need to enter a new person’s name
in the Name column). After entering a new code, the tab key moves across the row to
the Num column. The enter key either behaves in the same way or moves down a row
(see the Order Processing Options section above). After entering a number in the
Num column, the tab key moves to the code cell in the next row. Again, the enter key
either behaves the same or moves down a row depending on the option. You can use
shift tab or shift enter to move in the reverse direction (e.g. to go back and correct a
data entry error). If you enter a code that is invalid (not found in the catalogue), the
active cell is not moved when you hit tab or enter. Likewise, when in the Num
column, the active cell will not be moved if you fail to enter a number.

 The Entering orders section has been updated to reflect the use of this new mode.

• Made the Generate Sorter’s List menu item round fractional case totals to a
maximum of 2 decimal places. This allows columns to be as narrow as possible so
more will fit on a page.

• Improved the error checking that is done before sorting or generating the fax or
sorter’s lists. If any critical incomplete fields (e.g. missing names or entries in the
Num column) in the order are detected they will be highlighted and the user will have
a chance to fill them in. This should help avoid errors in the order from going
undetected.

• Any blank rows in the order are now automatically deleted whenever the order is
sorted or the fax or sorter’s list is generated.

• Product codes entered with any spaces in them are now automatically converted to
codes with no spaces in them when you look up the codes. In the past, looking up
such codes would fail.

• There is now a new options file (OPTIONS.XLS) and associated menu item used by
this software package. The options file is used to save the buying club name, delivery
address, etc. It is also used to store order processing behavioural options. The options
file is created automatically when this version of the software is first loaded into
Excel. Once created, it can be edited directly or by selecting either the Alter Order
Header Information … or Options … menu items in the ONFC menu.

The new order processing behavioural options are all described in the Order
Processing Options section on page 13.
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In future, when new versions of the software are distributed and loaded, these
options, as well as the club name, etc., will be remembered.

• Added 1% membership discount to totals generated for each persons order and to
grand totals. They are included automatically when using the Add in Totals function.
Note that the 1% discount is also applied automatically to the tax field as well (that is,
tax is calculated on any taxable item after its price has been reduced by 1% first).

• Fixed error that occurs in Excel 97 when using the Undo Printing Preparation
function.

• Reduced the size of the three *.XLT files (there was some junk in them taking up
space).

• Updated many of the descriptions in this manual and added descriptions of all the
new functionality.

Software Distribution Conditions
Club members are free to make a copy of the software from the ONFC. In other words, a
buying club should only need receive one copy of the software, even if two or more
members within the same club wish to install it on their computer. Please do not make
copies of the software for other buying clubs, instead ask them to get a copy of the
software from the ONFC.

The software should work on the PC and Macintosh. If you need to share the software
between a PC and a Mac, you should still only need to purchase one copy; however, you
will have to arrange to copy the files between the two different computers (perhaps the
Mac can read PC diskettes).

Contact Information
If you have questions or comments about these instructions or about the ONFC Excel
Macro Package, please contact its author:

Stephen Gabe
Phone: (613) 226-3250 (evenings and weekends)
Email: stephen.gabe@sympatico.ca

I hope you find this software useful and I look forward to hearing your comments and
ideas for improvements.


